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Einleitung 

Hinweise zu diesem Handbuch 

Mit diesem Handbuch erhalten Sie Hinweise und Informationen über die Funktion und Konfigura-
tion des DMX-View.  

 

Dieses Handbuch gilt für den DMX-View. Wie alle anderen Produkte aus dem Hause LSS GmbH unter-
liegt der DMX-View einer ständigen technischen Weiterentwicklung. Deshalb werden hier unter Um-
ständen Funktionen und Einstellungen beschrieben, die für den von Ihnen genutzten DMX-View nicht 
verfügbar sind. 

Dieses Handbuch nutzt folgende Symbole, um für Sie wichtige Hinweise zu Ihrer Sicherheit und zur 
Konfiguration kenntlich zu machen. 

 

Hier erhalten Sie zusätzliche Informationen.  

 

 

Ein Achtung weist Sie auf Situationen hin, in denen Entscheidungen zu technischen 
Problemen mit dem Gerät oder zu Datenverlusten führen können. 

 

 

Eine Warnung bezeichnet Situationen, in denen Verletzungen oder Schäden für Leib 
und Leben auftreten können. 

 

 

Sicherheitshinweise 

Der Umgang mit dem DMX-View ist nicht gefährlich. Schutzisolierung und weitere Sicherheits-
maßnahmen verhindern zuverlässig, dass Sie mit gesundheitsschädlichen Spannungen und Strö-
men in Berührung kommen. Beachten Sie aber folgende Hinweise: 

 

 Nehmen Sie niemals sichtbar beschädigte Geräte in Betrieb! 

 Liegt der Verdacht auf einen Defekt vor, trennen Sie das Gerät sofort von der 
Stromversorgung! Sichern Sie das Gerät gegen Wiederinbetriebnahme! 

 Trennen Sie vor der Abnahme der Rückwand das Gerät unbedingt vom Netzteil! 

 Reparaturen dürfen nur von einem autorisierten Händler oder von Mitarbeitern der 
LSS GmbH durchgeführt werden. 
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Hinweise zur Handhabung 

Der DMX-View ist für einen 24h Dauerbetrieb konzipiert. Dennoch sollten Sie folgendes beachten:  

 

 Setzen Sie das Gerät nur zu seinem bestimmungsgemäßen Zweck ein! 

 Vermeiden Sie extreme mechanische Belastungen! 

 Vermeiden Sie jegliche mechanische Einwirkungen auf das Display! 

 Wenn nötig reinigen Sie das Display ausschließlich bei ausgeschaltetem Gerät. Be-
nutzen Sie nur ein angefeuchtetes Tuch 

 Vermeiden Sie direkte Nässeeinwirkung sowie übermäßige Hitzeeinwirkung auf das 
Gerät! 

 Decken Sie die Belüftungsöffnungen niemals ab! Brandgefahr! 

 Montieren Sie das Gerät nicht unmittelbar über Scheinwerfern! 
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Der DMX-View 

Leistungsüberblick 

Der LSS DMX-View ist ein leichtes und transportables Diagnosegerät für DMX und ethernet-
basierende Lichtprotokolle. Er ist in der Lage, beispielsweise von einem Lichtpult ausgegebene 
Netzwerkprotokolle über Ethernet und/oder das Standard-DMX-Protokoll zu empfangen, zu ver-
arbeiten und visuell darzustellen. Die Anzeige erfolgt übersichtlich auf einer Matrix aus 512 schnell 
ansprechenden und dimmbaren LEDs. Frei einstellbare DMX-Universen und Subnetze können 
überwacht und auftretende Fehler, wie zum Beispiel zeitliche Versätze, DMX-Instabilitäten („Fli-
ckerFinder“) oder gar der Ausfall einzelner Kanäle, schnell erkannt werden. 

 

Der LSS DMX-View kann wahlweise mit einem externen Netzgerät oder mit einem intern verbau-
ten Akku betrieben werden, der für eine Dauerleistung von mindestens zwei Stunden ausgelegt 
ist. Das macht den DMX-View zu einem Überwachungsgerät, das besonders für einen Einsatz an 
dezentralen und für Wartung und Überwachung schwierigen Orten geeignet ist. Durch seine passi-
ve Kühlung ohne Lüfter kann er sogar in akustisch heiklen Situationen zum Einsatz kommen.  

 

 

 

 

 

Unterstütze  

Protokolle:   Art-Net  ShowNet 

    AVAB/UDP  AVAB/IPX 

    sACN   DMX512 

 

Diagnose-Display:  Anzeige eines kompletten DMX-Universe mit 512 dimmbaren LEDs 

    Lineare oder logarithmische Kennlinie auswählbar 

 

Menü-Eingabe:  20x4 LCD-Display mit 4 Tasten-Menüsystem 

 

Anschlüsse:   1x LAN RJ45, 100MBit 

    1x DMX-In, 5-polig XLR, optisch potentialgetrennt 

    1x DMX-Thru, 5-polig XLR 
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Remotekonfiguration 

Für alle LSS-Geräte wird die kostenlose Software ConfigCore empfohlen, die alle Features des 
DMX-View und anderer LSS-Geräte, aber auch Art-Net-Geräte anderer Hersteller unterstützt. Nur 
mit dieser Software ist es möglich, alle Geräte im Netzwerk aufzufinden und den DMX-View kom-
plett remote zu konfigurieren. 

Als Art-Net-kompatibles Gerät arbeitet der DMX-View problemlos mit Art-Net-Softwaretools ande-
rer Hersteller, wie z.B. dem Programm DMX-Workshop zusammen (Download unter 
www.artisticlicence.com). Selbstverständlich hat der DMX-View wie alle anderen Art-Net-Geräte 
eine eigene OEM-ID (ab Workshop-Version 3.57 erkannt und unterstützt). Über dieses Tool ist 
auch eine eingeschränkte Remote-Konfiguration möglich, eingeschränkt deshalb, weil Art-Net hier 
nur eine Untermenge des DMX-View konfigurieren kann.  

 

Auch bei anderen eingestellten Licht-Protokollen als Art-Net ist der DMX-View mit Con-
figCore immer konfigurierbar, es wird lediglich vorausgesetzt, dass der PC im IP-
Adressbereich des DMX-View liegt. 

 

 

Mergeverhalten 

Der DMX-View kann bei Anlagen, die auf dem gleichen Subnetz/Universe senden, bis zu 4 Anlagen 
HTP-mergen. Dies zeichnet ihn von den meisten anderen Geräten dieser Art aus. Art-Net sieht z.B. 
hier nur 1 oder max. 2 Anlagen vor. 
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Anschluss-, Anzeige- und Bedienelemente 

Geräteübersicht 

Die Anschlüsse, Anzeigen und Bedienelemente des LSS DMX-View sind klar und strukturiert am 
Gehäuse angeordnet. Dadurch ist auch bei schlechten Lichtverhältnissen ein einfacher Anschluss 
von Steuerleitungen gewährleistet. 

 

Konfigurationsmenü 

 

 

 

 

 

 

Diagnose Display          Anschlüsse 

 

 

 

 

 

 

 

 

        Betriebsanzeigen 

 

 

Diagnose-Display 

Das Diagnose-Display stellt mit Hilfe von 512 LED ein komplettes Universe dar. Jede LED ist dabei 
exakt einem Kreis bzw. Kanal mit Kreisnummer zugeordnet. Die LED sind dimmbar und können so 
auch die Werte der einzelnen Kreise optisch wiedergeben.  

 

Mit der Software-Version 1.24 wurde das Anzeigevermögen um eine Anzeige der Universen und 
Subnets erweitert.  
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Betriebsanzeigen 

Die Betriebsanzeigen an der Frontseite geben die Situation der Spannungsversorgung und wieder. 

 

 

 

 

 

 

LED Farbe Bedeutung 

Bat. Failure rot Akkutemperatur zu hoch 

Ladeprozess wurde kurz vor Vollladung unterbrochen und neu gestartet 
→ Akku abkühlen lassen (kann bis 1 Stunde dauern) 

 

Akku defekt (bei wiederholter Meldung) 

Bitte Gerät zum Service einschicken, Akku muss gewechselt werden. 

Bat. Charging gelb Akku wird geladen 

Ext. Power grün Externe Spannungsversorgung vorhanden 

 

Anschlüsse 

An der rechten Gehäuseseite befinden sich die Anschlüsse für DMX, Ethernet und die Spannungs-
versorgung. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Anschluss Anschlussart 

12 V DC Anschluss externes Netzteil 12V DC, 3A 

(Hohlstecker 5,5/2,1mm) 

Ethernet Anschluss Ethernet RJ45, 100MBit 

DMX-In Anschluss DMX, 5-polig XLR, optisch getrennt 

DMX-Thru Anschluss DMX. 5 polig XLR 
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Konfigurationsmenü 

Die Konfiguration des DMX-View erfolgt lokal über ein komfortables Menüsystem. Zu diesem 
Zweck enthält das Gerät ein blau-weiß leuchtendes 20x4 LCD-Display mit stromsparender LED-
Hintergrundbeleuchtung und langer Lebensdauer. Die Lebensdauer wird noch um ein Vielfaches 
erhöht, wenn der Bildschirmschoner verwendet wird.  

 

Bedient wird das Menü mit vier Tasten, die bereits von anderen Geräten von LSS bekannt sind. 

 

 

 

 

 

 

 

 

Taste Bedeutung 

MENU Zugang zu Haupt- und Untermenüs 

← Scroll durch die Menüs 

→ Scroll durch die Menüs 

OK Bestätigung von Einstellungen 

 

 

Oberhalb des Displays werden mittels LED zwei weitere Betriebszustände angezeigt. 

 

LED Bedeutung 

POWER (blau) Betriebsspannung liegt an 

ACTIVE (gelb) Ein:  Ethernetverbindung besteht, kein Datenaustausch 

Blinkt:  Ethernetverbindung besteht, Datenaustausch besteht 

Aus:  Ethernetverbindung besteht nicht 
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Konfiguration des DMX-View 

Menüsystem 

Das Menü wird mit den Tastern unterhalb des Menü-Displays bedient. Die Funktion der 4 Tasten 
wirkt sich im Detail je nach Menübedienung etwas unterschiedlich aus, ist im Prinzip aber immer 
gleich. Die Tasten ← und → haben eine Beschleunigungsfunktion, die beim Festhalten die Eingabe 
großer Zahlen erleichtert. Ab 100 bzw. 1000 wird jeweils um den Faktor 10 beschleunigt. 

 

Eingabe von Parametern oder Zahlen 

Die Eingabe von Parametern oder Zahlen z.B. auf Config-Seiten geschieht wie folgt: 

 Parameterzeile auswählen mit  ← und → 

 „Ok“  

 am Parameter blinkt nun der Cursor 

 Parameter ändern mit ← und → (Schnelldurchlauf mit Festhalten) 

 „Ok“ für Ändern oder „Menu“ für Abbruch (der Cursor blinkt nun nicht mehr) 

 

Eingabe von Namen oder IP-Adressen 

Die Eingabe von Namen oder IP-Adressen geschieht wie folgt: 

 Parameterzeile auswählen mit  ← und → 

 „Ok“  

 unter der ersten Stelle ist nun der Cursor ein Unterstrich _ 

 Stelle auswählen mit  ← und → 

 „Ok“ 

 an der Stelle blinkt nun der Cursor 

 Ziffer/Buchstabe ändern mit ← und → (Schnelldurchlauf mit Festhalten) 

 „Ok“ für Ändern oder „Menu“ für Abbruch (der Cursor ist nun wieder ein Unterstrich) 

 nächste Ziffer/Buchstabe auswählen, ändern usw. 

 wenn der Text oder die IP-Adresse geändert wurde, „Menu“ drücken; der Unterstrich ver-
schwindet 
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Speichern von Einstellungen 

Wenn Parameter wirklich geändert wurden, zeigt dies ein * dahinter an. Die Seite wird mit 

„Menu“ verlassen. Sind geänderte Parameter auf der Seite vorhanden, erfolgt die Rückfrage „Sa-
ve?“. Wird diese mit „Ok“ beantwortet, werden die geänderten Parameter gespeichert und sofort 
wirksam. Wird die Rückfrage mit „Menu“ beantwortet, werden alle Änderungen verworfen. 

 

 

Legende zur Schematische Darstellung des Menüs 

Der Aufbau des Menüs und die Konfigurationsmöglichkeiten werden im Folgenden schematisch 
dargestellt. Die verwendeten Symbole haben folgende Bedeutung: 

 

Symbol Bedeutung 

OK Auswahl „OK“ führt zum nächsten Menüpunkt bzw. hat folgende Auswirkung 

MENU Auswahl „MENU“ führt zum nächsten Menüpunkt bzw. hat folgende Auswirkung 

 

 

 

 

 

 

 

 

 

 

 

 

Display-Anzeige 

 

Anzeigenname 

 

 

 

 

Anzeigen/Parameter zur Auswahl 

 

 

 

⇆ Auswahl mit den Pfeiltasten 
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Grundzustand 

Im Grundzustand scrollt das Menü des DMX-View durch verschiedene Diagnoseseiten. Diese Sei-
ten geben einen schnellen Überblick über verschiedene Einstellungen und den Betriebszustand 
des Gerätes. 

 

 

 
 

Wenn die Tasten längere Zeit nicht betätigt werden, geht der DMX-View automatisch in den 
Grundzustand zurück.  

 

Anzeige von Universen und Subnets 

Ab der Software-Version 1.24 ist es nicht mehr möglich, manuell durch die Anzeigen des Grundzu-
standes zu scrollen. Stattdessen können mit den Pfeiltasten ← und → die Universen und zugeord-
neten Subnets auf dem Diagnose-Display angezeigt werden.  
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PIN-Abfrage 

Vom Hauptmenü aus werden alle anderen aufgerufen. Falls eine PIN vergeben wurde, wird diese 
vor der Anzeige des Hauptmenüs abgefragt: 

 

 

 
 

 

Die Eingabe erfolgt mit den Bedientasten und wird mit „OK“ bestätigt. Zur Sicherheit wird vor uns 
nach dem Scrollen nur [*****] angezeigt.  

 

 

Hauptmenü 

Vom Hauptmenü werden alle anderen Menüs aufgerufen. Um vom Grundzustand aus das Haupt-
menü aufrufen zu können, muss die Taste „Menu“ gedrückt werden. Das Hauptmenü ist unterteilt 
in Monitoring-Menüs, Konfigurationsmenüs und weitere Einstellungen. 

 

 
 

Auswahl Bedeutung 

View Auswahl der Netzwerk- und DMX-Monitore 

Config Auswahl des Menüs zur Einstellung des DMX-View 

Options Auswahl des Menüs zur Einstellung der Zusatzfunktionen 

Version Auswahl der Versionsinformationen 

MENU Rückkehr in den Grundzustand 

OK Bestätigung der Auswahl 
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View-Menü 

Mit den Monitoren im View-Menü erhalten Sie einen Überblick über die aktuellen Einstellungen 
des DMX-View. Aktuelle Ereignisse, Daten-In- und –Output werden ebenso dargestellt wie die 
Merge-Situation. Die Anzeigen im View-Menü verstehen sich als Monitore und sind in Echtzeit. 
Dadurch lassen sie sich problemlos als Überwachungs- und Diagnosetools einsetzen. 

 

Aufbau des View-Menüs 
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View→DMX 

Dieser Monitor gibt einen Überblick über die Aktivitäten am DMX-In. Im Untermenü für Port 1 und 
2 können die Signale für jedes Bit hexadezimal oder prozentual dargestellt werden. Die Ports 3 und 
4 haben keinerlei Bedeutung.  

 

Anzeige Bedeutung 

DMX 1…4 DMX-Port 1…4 

Achtung! Port 3 und 4 haben keinerlei Bedeutung! 

IN Voll: am DMX-Eingang wird ein korrektes DMX-Protokoll empfangen 

E: DMX-Protokoll am Eingang ist ungültig (Startcode oder Timing) 

Leer: kein Signal am DMX-Eingang 

Out Das Diagnose-Display wird als Port 2 definiert und als DMX-Out angesteuert. 

Voll: am DMX-Ausgang wird ein DMX-Protokoll ausgesendet 

H: DMX-Ausgang ist auf HOLD und hält die letzten Daten 

Z: DMX-Ausgang ist auf HOLD und sendet Nullprotokolle 

Leer: DMX-Ausgang ist abgeschaltet 

Cnt Anzeige der gesendeten Pakete pro Sekunde 

F Anzeige der Framerate pro Sekunde 

MENU Rückkehr ins übergeordnete Menü 

OK Auswahl bestätigen 

 

View→Network 

In diesem Monitor werden die aktuellen Einstellungen an den DMX-Ports angezeigt. Im Unterme-
nü für Port 1 und 2 können die Signale für jedes Bit hexadezimal oder prozentual dargestellt wer-
den. Die Ports 3 und 4 haben keinerlei Bedeutung.  

 

Anzeige Bedeutung 

1…4 DMX 1…4 

Act voll: auf dieser Subnet/Universe-Kombination wird Licht empfangen 

leer: auf dieser Subnet/Universe-Kombination wird kein Licht empfangen 

Sub logisches Subnet (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist, wird „-“ angezeigt. 

Uni Universe (lichtprotokollabhängig) 

Wenn der DMX-Port im Routing abgeschaltet ist, wird „-“ angezeigt. 

OK Menü aufrufen/Auswahl bestätigen 

MENU Rückkehr ins übergeordnete Menü 
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View→NWCount 

Dieses Auswahlmenü führt zu Monitoren, die einen Überblick über eigehende und ausgehende 
Daten und Datenpakete geben. Die Monitore geben ihre Informationen sehr umfangreich wieder, 
so dass man diese Informationen zur Netzwerkdiagnose nutzen kann. 

 

Anzeige Bedeutung 

In Aufruf Netzwerkzähleranzeigen für empfangene Daten 

Out Aufruf Netzwerkzähleranzeigen für gesendete Daten 

Data Aufruf Netzwerkzähler für Datenpakete 

OK Menü aufrufen 

MENU Rückkehr ins übergeordnete Menü 

 

 

View→NWCount→In/Out 

Anzeige Bedeutung 

Count  

kByte empfangene kByte 

Packets empfangene Pakete 

Errors Summe der Empfangsfehler 

Errors1  

Dropped Empfangsüberlauf durch zu viele Pakete 

Overrun (nur In) Empfangsüberlauf durch zu viele Pakete 

Aborted (nur Out) Abgebrochene Pakete 

Length (nur In) Pakete mit Längenfehler 

Carrier (nur Out) Ethernet-Carrier verloren 

Errors2  

CRC (nur In) CRC-Empfangsfehler 

Heartbt (nur Out) Ethernet Heartbeat verloren 

Frame Frame Fehler 

FIFO Überlauf Ethernet FIFO 

MENU Rückkehr ins übergeordnete Menü 
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View→NWCount→Data 

Anzeige Bedeutung 

Rx Empfangene Datenmengen 

Tx Gesendete Datenmengen 

Pack./s Pakete pro Sekunde 

kByte Datenmenge in kByte 

MENU Rückkehr ins übergeordnete Menü 
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Config-Menü 

Im Config-Menü können Sie die vielfältigen Einstellungsmöglichkeiten des DMX-View komfortabel 
ändern. Zu Ihrer eigenen Sicherheit müssen Sie vor jeder Änderung der Einstellungen diese Ände-
rung auch bestätigen.  

 

Aufbau des Config-Menüs 
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Menü Einstellungsmöglichkeiten 

Routing Einstellung des Merge-Verhaltens 

DMX Einstellung des Verhaltens der DMX-Ausgänge bei Signalverlust 

Network Einstellung der Ethernet-basierenden Netzwerkprotokolle 

LED Einstellung des Diagnose-Displays 

OK Menü aufrufen 

MENU Rückkehr ins übergeordnete Menü 

 

Config→Routing 

In diesem Menü wird das Merge-Verhalten des DMX-View festgelegt. Es können Daten von bis zu 
vier Ethernet- und einem DMX-Sendern zusammengefasst werden. Ausgegeben werden sie aber 
nur über den DMX-Port 2.  

 

Auswahl Bedeutung 

Mode Off: Ethernet wird nicht empfangen, DMX-Out abgeschaltet 

 

Single:  

Es werden nur die vom ersten Sender empfangenen Lichtdaten verwendet. Sollten 
gleichzeitig von mehreren Sendern Telegramme mit dem eingestellten Subnetz und 
Universe anliegen, wird nur der als erstes er kannte Sender berücksichtigt. Die Sen-
der-Erkennung erfolgt bei AVAB/IPX direkt durch Auswertung der MAC-Adresse 
(Ethernetadresse), bei sACN nach der Geräte-ID und bei allen anderen Protokollen 
durch die IP-Adresse des Senders, die für jeden Sender individuell sein muss. Bei 
Ausbleiben des Sendersignals wird nach der Timeout-Zeit (Pufferzeit) ggf. ein ande-
rer Sender ermittelt (Prinzip: „Der erste darf“). 

 

Merge4: 

Es werden die Daten von bis zu 4 Ethernet-Sendern nach dem HTP-Prinzip zusam-
mengefasst. Sollten gleichzeitig von mehr als 4 Sendern Telegramme mit dem Sub-
netz und Universe dieses Ausgangs anliegen, werden nur die ersten 4 erkannten 
Sender berücksichtigt. Bei Ausbleiben eines Sendersignale wird nach der Timeout-
Zeit ggf. ein anderer Sender ermittelt (Prinzip: „wer zuerst kommt“). 

 

DmxIn1: Es werden nur DMX-Lichtdaten verwendet. 

 

All: Es werden die Daten aus Ethernet und DMX-In verwendet.  

Universe Einstellung des Sende-Universes (lichtprotokollabhängig) 

Subnet Einstellung des Sende-Subnets (lichtprotokollabhängig) 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→DMX 

In diesem Menü wird das Verhalten des Diagnose-Displays, das als DMX-Out definiert ist, bei Emp-
fangsausfall festgelegt. Es gilt dabei zu beachten, dass die Einstellungen „Break“ und „MAB“ beim 
DMX-View keinerlei Bedeutung haben. 

 

Auswahl Bedeutung 

DMX-Out Off: bei Empfangsausfall wird der DMX-Out abgeschaltet 

Hold: der letzte empfangene Stand wird unverändert weitergesendet 

Zero: bei Empfangsausfall werden Nullen weitergesendet 

Break hat keine Bedeutung 

MAB hat keine Bedeutung 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Config→Network 

Im Network-Menü werden die auf dem Ethernet basierenden Netzwerkprotokolle eingestellt. Es 
ist zu beachten, dass der DMX-View nur Lichtprotokolle empfangen kann. Dem ist das Menü ange-
passt. 

 

Config→Network→Light 

Auswahl Bedeutung 

Protocol Einstellung des Netzwerkprotokolls für Licht-Empfang: 

Art-Net 

AVAB/IPX 

AVAB/UDP 

ShowNet 

sACN 

Timeout Einstellung des Timeouts für Lichtprotokolle  

0…999 s  (0 = letztes Protokoll halten) 

Name Einstellung des Art-Net ShortName zur Benennung des DMX-View 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network→IP Mode 

In diesem Menü wird der Erhalt der IP-Adresse eingestellt. Für Art-Net gibt es nach Art-Net Spezifi-
kation 2 feste Möglichkeiten, 2.x.y.z und 10.x.y.z. Dabei wird die IP unter Einbezug der Hersteller-
ID und der MAC-Adresse gebildet. Außerdem kann die IP-Adresse sowohl vollkommen frei als auch 
per DHCP eingestellt werden. 

 

Auswahl Bedeutung 

IP Mode Bezug der IP-Adresse: 

Manual: freie Einstellmöglichkeit, siehe TCP/IP-Menü 

Art-Net 2: Art-Net-Adresse im 2er Netz 

Art-Net 10: Art-Net-Adresse im 10er Netz 

DHCP:  wenn DHCP-Server im Netzwerk vorhanden 

Media Auto Neg: AutoNegotion – automatische Übertragungsgeschwindig-
keit 

100 Full: 100Mbit Full-Duplex 

100 Half: 100Mbit Half-Duplex 

10 Full: 10Mbit Full-Duplex 

10 Half: 10 Mbit Half-Duplex 

UDP CS On:  UDP-Checksum wird bei jedem Paket berechnet 

Send Off: UDP-Checksum wird beim Senden nicht kontrolliert 

Recv Off: UDP-Checksum wird beim Empfangen nicht kontrolliert 

Off:  UDP-Checksum wird nicht kontrolliert 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Config→Network→TCP/IP 

In diesem Menü kann im IP-Mode „Manual“ die IP-Adresse, die Netzwerkmaske und das Gateway 
frei eingestellt werden. Die Angabe des Gateways ist normalerweise nicht erforderlich, da Licht 
nicht geroutet wird. In allen anderen IP-Modi ist nur das Gateway frei einstellbar. 

 

Auswahl Bedeutung 

IP IP-Adresse 

SN Netzwerkmaske 

GW Gateway 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Config→Network→Options 

In diesem Menü werden spezielle Einstellungen  

 

Auswahl Bedeutung 

sACN Draft Auswahl des unterstützen sACN-Protokolls  
Off: MasterPort 2 PSU sendet sACN nach Standard E1.31 2009  

On: MasterPort 2 PSU sendet sACN nach Standard E1.31 R0 Draft  

Art-Net 255 Art-Net wird als Broadcast gesendet. Wird der DMX-View in ADB-Anlagen 
eingebunden, ist diese Einstellung notwendig.  

Art-Net 3Net Einstellung der Art-Net3 IP-Adresse.  
0:  Art-Net3 ist deaktiviert  

1-127:  Art-Net3 ist aktiv und Ziffer gibt die IP-Adresse an.  

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Config→LED 

In diesem Menü wird das Verhalten des Diagnose-Displays eingestellt. Neben zweier Dimmerkur-
ven ist das Anzeigeverhalten der LEDs einstellbar. 

 

Config→LED→LedCurve 

In diesem Menü können zwei Dimmerkurven eingestellt werden. 

Anzeige Bedeutung 

Linear Linearer Beleuchtungsoutput  

Logarith e-Funktion 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Config→LED→SyncMode 

In diesem Menü wird das Ansprechverhalten der LED angezeigt. 

Anzeige Bedeutung 

Off LED geben die eintreffenden Protokolle asynchron wieder 

On LED geben die eintreffenden Protokolle synchron wieder 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 
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Options-Menü 

Im Menü Options werden die Zusatzeinstellungen des DMX-View festgelegt. 

 

Aufbau des Options-Menü 
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Options→Display 

Hier werden die Einstellungen für das Display festgelegt. 

Auswahl Bedeutung 

ScreenSaver Timeout für Backlight-Abschaltung des Displays. Die Abschaltung des Back-
lights erhöht die Lebensdauer des Displays erheblich.  

Eingaben am Menü, per Remote-Steuerung oder Events beenden den Zu-
stand. 

(OFF, 15s, 30s, 1m, 3m, 5m, 10m, 15m, 20m, 30m, 45m, 1h, 2h, 3h, 4h, 6h, 8h, 
12h, 24h) 

Events On:  Statusänderungen an DMX-In/Out oder Ethernet schalten 
  Bildschirmschoner aus und zeigen die jeweilige Statusseite  

Off:  Statusänderungen wirken sich nicht auf Bildschirmschoner 
  aus 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Options→Security 

In diesem Menü werden die Sicherheitseinstellungen festgelegt. 

Auswahl Bedeutung 

Pin Hauptmenü-Pin 

0…30000s (0 = aus) 

Remote On: DMX-View ist per Art-Net programmierbar 

Off: DMX-View ist nicht per Art-Net programmierbar 

OK Parameter einstellen 

MENU Rückkehr ins übergeordnete Menü/Parameter speichern 

 

 

Obwohl das System eine Auswahl aus 30.000 möglichen Pins bietet, kann eine abso-
lute Sicherheit nicht gewährleistet werden! Treffen Sie geeignete Maßnahmen vor 
Ort, um einen nicht autorisierten Zugriff zu verhindern! 
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Options→Factory Defaults  

Hier werden alle Einstellungen der Steuereinheit des DMX-View auf die Werkseinstellungen zu-
rückgesetzt.  Um einen Datenverlust vorzubeugen, ist eine doppelte Bestätigung zum Laden der 
Default-Werte notwendig.  

 

Options→Reset 

Mit der Anwahl dieses Menüpunktes wird ein CPU-Reset ausgelöst. Nach dem Reset werden die 
gespeicherten Parameter geladen.  

Beim Ändern folgender Einstellungen führt der DMX-View nachfolgend automatisch einen Reset 
aus: 

 Lichtempfangsprotokoll  Lichtsendeprotokoll 

 IP-Mode  IP-Adresse 

 Netzwerkmaske  Gateway 

 Defaultwerte laden  

 

 

Version 

Hier wird die aktuelle Firmware-Version angezeigt. 

 

Anzeige Bedeutung 

© 2011 LSS GmbH Hersteller 

Ver. 1.20 Rev. 04 Software-Version 

Feb 29 2012 13:04:00 Datum und Uhrzeit 

MENU Rückkehr ins übergeordnete Menü 
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Schnellkonfiguration 

Voraussetzung für die Schnellkonfiguration: es wurden vorher unter Options→Default die Werks-

einstellungen geladen. 

 

Werkseinstellungen 

Die Werkseinstellungen des DMX-View sind: 
 Merge-Verhalten:  alle 

 gemergetes Universe:  0 

 gemergetes Subnet:  0 

 DMX-Out bei Empfangsausfall: aus 

 LEDCurve:   Linear 

 SyncMode:   aus 

 Netzwerkprotokoll:   Art-Net  (Empfang und Senden) 

 IP-Mode:   Art-Net 2er Netz 

 IP:     nach Art-Net Standard  (2.x.y.z) 

 Netzwerk-Maske:  255.0.0.0 

 Gateway:   192.168.172.254 

 Empfangstimeout:   8 s 

 Art-Net Name:    LSS DMX-View 

 Bildschirmschoner:  15 min, aus bei Statusänderungen 

 Pinabfrage:   aus 

 Art-Net Fernsteuerung:  ein 
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Wartung und Pflege 

Wartung und Pflege des Akku 

Der LSS DMX-View ist mit einem 7,2V/2400mAh NiMH-Akku ausgestattet. Die hohe Energiedichte 
eines NiMH-Akkus ermöglicht eine gleichbleibende Spannungsabgabe mit hoher Stromstärke im 
Akkubetrieb. Für den Betrieb und das Laden sollten folgende Hinweise beachtet werden. 

 

Ladezyklen 

NiMH-Akkus neigen zu einer vergleichsweise schnellen Selbstentladung und reagieren negativ auf 
Tiefentladungen. Man muss davon ausgehen, dass die im DMX-View verwendeten Akkus drei Mo-
nate nach dem letzten Laden entladen sind. Zur Aufrechterhaltung der Ladekapazitäten sollten 
deshalb die NiMH-Akkus regelmäßig vierteljährlich geladen werden. 

Der DMX-View ist in der Lage, den internen Akku unabhängig vom Hauptschalter zu laden. Mit 
dem Anschluss einer externen Spannungsversorgung wird der Ladevorgang gestartet. 

 

Wärmeentwicklung beim Laden und im Betrieb 

Die NiMH-Akkus werden im laufenden Betrieb des LSS DMX-View geladen. Es ist völlig normal, 
dass sich während des Aufladens und während des Betriebs die Akkus erwärmen. Die Wärme wird 
über das Gehäuse abgegeben. Intern werden die Akkus von intelligenten Temperatur-Controllern 
überwacht, die im Extremfall den Betrieb oder das Laden unterbrechen.  

 

Fehlermeldungen oder Probleme mit dem Einschaltverhalten 

Die Betriebsanzeigen auf der Frontseite dienen zum einen der Information über die verwendete 
Stromversorgung, geben aber auch Fehlermeldungen und Warnhinweise aus. Zuständig dafür ist 
die Anzeige „Bat. Failure“.  

 

Rote „Bat. Failure“ während des Betriebs 

Die Temperatur der Akkus ist zu hoch. Der DMX-View muss abgeschaltet werden und einige Zeit 
abkühlen. Dies kann bis zu einer Stunde dauern. 

 

Häufige Anzeige „Bat. Failure“ während des Betriebs 

Leuchtet die Anzeige regelmäßig und nach annähernd gleicher Zeit nach dem Einschalten auf, ist 
dies Hinweis darauf, dass der Akku gewechselt werden muss. Dazu setzen Sie sich bitte mit der 
Service-Abteilung der LSS GmbH in Verbindung und schicken Sie das Gerät ein. 
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Gerät lässt sich nicht einschalten 

Wird der DMX-Viewer kurz nach dem Ausschalten erneut eingeschaltet, ist es möglich, dass das 
Gerät sich nicht einschalten lässt. Dies ist eine völlig normale Situation! 

Beim ersten Betrieb wurde der Akku geladen und wurde dabei warm. Die Zeit zwischen Aus- und 
erneutem Einschalten war zu kurz, dass der Akku sich abkühlen konnte. Beim Einschalten muss der 
Akku eine signifikant niedrigere Temperatur haben, als am Ende eines Ladevorgangs. Beim Ein-
schalten wird die aktuelle Temperatur von den Temperatur-Controllern gemessen, die wiederum 
den Betrieb freigeben. 

In diesem Fall muss der Akku sich weiter abkühlen. 
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Begriffe 

ACN „Architecture for Control Networks“ 

Von einem internationalen Gremium unter Führung der ESTA standardisierte Netzwerk-
protokoll-Suite für Geräte im Entertainment Bereich. Beinhaltet sehr umfangreiche Me-
chanismen und Vorgaben für die in den Geräten verwendeten Netzwerkprotokolle, Er-
kennungsmechanismen, Konfigurationsmöglichkeiten mittels XML-Files, Datenübertra-
gungen usw. 

Bisher werden von vielen Herstellern aus Aufwandsgründen (der Standard enthält über 
400 Seiten) nur Untermengen von ACN implementiert, z.B. die Streaming-Daten für Licht-
Universes (sACN). 

Broadcast In der Netzwerktechnik Protokolle, die an ganze Subnetze (Subnetz-Broadcast) oder „an 
alle“ Netzwerkteilnehmer gesendet werden. Broadcasts sind sehr ineffizient, weil das 
Netzwerk und alle Teilnehmer belastet werden und sollten daher wenn möglich durch 
Multicast ersetzt werden.  

Broadcasts werden nicht geroutet. 

Broadcasts „an alle“ verwenden in der Lichttechnik z.B. AVAB/IPX und AVAB/UDP. 

Art-Net verwendet zum Teil Subnetz-Broadcasts, was de facto auch einem Broadcast für 
alle Art-Net-Geräte gleichkommt. 

DMX DMX512 

1990 von der USITT vorgeschlagenes Bussystem für Licht- und Medientechnik. Später als 
DIN 56930-2 und ANSI Standard E1.11 festgelegt. 

HTP Highest Takes Precedence 

Übliche Form des Mergens von DMX-Daten: der höchste Wert mehrerer Eingänge be-
stimmt den Ausgabewert. 

IGMP Internet Group Managment Protocol. 

Wird u.a. im Zusammenhang mit Multicast und zur intelligenten Verteilung der Netzlast 
verwendet. Multicast-Teilnehmer melden sich damit z.B. im Netzwerk an und ab, um in-
telligenten Switches mitzuteilen, dass Protokolle ihres Adressbereichs an bestimmten 
Ports ausgegeben werden sollen. 

Es gibt mittlerweile 3 verschiedene Versionen v1…v3. 

IP Internet Protocol. Computernetzwerkprotokoll, Grundlage des Internet. Erste, vom Über-
tragungsmedium unabhängige Protokollschicht. Ermöglicht eine Adressierung von Netz-
werkteilnehmern und Gruppen mittels IP-Adresse und Subnetzmaske, ist damit auch rou-
tingfähig. 

IP-Adresse Netzwerknummer eines Teilnehmers in einem IP-Netz. 32-stellige Binärzahl, wird meist 
als 4-stellige Dezimalzahl im Bereich von 0…255 geschrieben, z.B.  192.168.0.1. Damit ist 
jeder Teilnehmer eindeutig identifizierbar. Gruppen von Teilnehmern werden über 
Broadcasts erreicht, wenn die Nummer 255 ist, z.B. 172.16.100.255 entspricht den Teil-
nehmern 172.16.100.1 … 172.16.100.254 

IP-Netzmaske Netzmaske oder Netzwerkmaske, teils noch als Subnetzmaske bezeichnet. Eine Bitmaske, 
die eine IP-Adresse in einen Netzwerk- und einen Geräte- bzw. Hostteil trennt. Sie wird in 
IP-Netzwerken verwendet, um Routing-Entscheidungen zu treffen und Geräte zu be-
stimmten Gruppen zuzuordnen. Nur Geräte mit gleichem Netzwerkteil können direkt 
miteinander kommunizieren. 

IPX Internetwork Packet eXchange. Von Novell ursprünglich für das Netzwerkbetriebssystem 
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NetWare eingeführtes Computer-Netzwerkprotokoll. Verlor seit Anfang der 90er Jahre 
gegenüber TCP/IP zunehmend an Bedeutung. In der Lichttechnik werden IPX-Pakete nur 
vom AVAB/IPX - Lichtprotokoll verwendet. 

Licht-Protokoll Über Ethernet übertragenes Datenprotokoll, das Lichtinformationen überträgt. Lichtpro-
tokolle sind herstellerspezifisch und meist nicht offengelegt (Ausnahmen: Art-Net, ACN). 

LTP Last Takes Precedence 

Form des Mergens von DMX-Daten: der zuletzt eingetroffene Wert von mehreren Ein-
gängen bestimmt den Ausgabewert. Häufig verwendet von beweglicher Mechanik wie 
MovingLights. 

Multicast In der Netzwerktechnik Protokolle, die an mehrere Netzwerkteilnehmer oder Gruppen 
von Teilnehmern gesendet werden. Multicasts sind sehr effizient, weil die Teilnehmerfil-
terung auf Hardwareebene geschieht und Unbeteiligte nicht belastet werden. Multicast-
IP-Adressen haben einen eigenen Adressbereich, die MAC-Adresse wird von der IP-
Adresse abgeleitet. 

In der Lichttechnik wird Multicast z.B. von ACN und ETCNet2 verwendet. 

Intelligente Switches leiten Multicastprotokolle nur zu Teilnehmern, die sich dafür beim 
Switch anmelden. Hierfür gibt es das IGMP-Protokoll. 

Profibus Der international am weitesten verbreitete Industrie-Feldbus, seinerzeit von einer Grup-
pe Hersteller unter Federführung von Siemens entwickelt, in Europa seit langem standar-
disiert durch EN50170. Profibus ist physikalisch meist eine RS-485-Schnittstelle mit zeit-
lich determiniertem, Token-Ring-ähnlichem Protokoll. Genauso ist auch Lichtwellenleiter 
und Profinet (Industrial Ethernet) möglich. Es kann mehrere Master und Slaves sowie 
verschiedene Busprotokolle (FMS, DP,…) auf dem Bus geben. 

Dachorganisation PI International mit über 1500 Herstellern, in Deutschland durch die 
PNO vertreten. LSS ist Mitglied der PNO, alle LSS Profibusgeräte sind bei der PNO regis-
triert. 

Profibus-DP Auf hohen Datendurchsatz und geringe Übertragungszeiten optimiertes Profibusproto-
koll. Die Daten werden zyklisch und zeitlich determiniert übertragen, wobei ein Master 
jeweils bis zu 125 Slaves ansteuern kann. 

Profibus-DP ist in vielen Siemens S7-CPUs bereits als Standard-Schnittstelle enthalten und 
erfordert somit keinen weiteren Hardwareaufwand. 

RDM Remote Device Managment over DMX512 Networks 

American National Standard (ANSI) E1.20 der ESTA (Entertainment Services and Technol-
ogy Association) 

Erlaubt eine bi-direktionale Übertragung auf dem DMX512-Bus zur Konfiguration, Diag-
nose und Rückmeldung intelligenter DMX-Geräte. 

Socket Schnittstelle zwischen Ethernet-Empfänger und Firmware des MasterGate. Bezeichnet 
hier den Empfangs- und Sendepuffer für eine Subnet/Universe-Kombination eines einzel-
nen Netzwerk-Senders. 

SPS Speicherprogrammierbare Steuerung (z.B: Siemens S7-300/400) 

Stimmungs-
speicher 

Speicher für eine begrenzte Anzahl von beliebigen Lichtprotokollen im MasterGate. Über 
eine Vielzahl von Steuermöglichkeiten kann so eine komfortable kleine Proben- oder Ha-
varielichtanlage realisiert werden. 

Subnet In Lichtprotokollen mancher Hersteller einstellbare Netznummer, dem sich am Ethernet 
angeschlossene Geräte zuordnen lassen. Subnets dienen dazu, die Netzwerkstruktur 
übersichtlich zu gestalten. 

Nicht verwechseln mit IP-Netzmaske! 
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TCP Transmission Control Protocol. Zuverlässiges Datenaustauschprotokoll für Computer-
netzwerke, welches meist auf IP basiert und mit diesem zusammen als TCP/IP bezeichnet 
wird. Die Übertragung erfolgt verbindungsorientiert und gegen Übertragungsfehler gesi-
chert. Wird bei Lichtnetzwerken für alle Arten des Datenaustauschs zwischen Anlagen 
verwendet, wo es nicht so sehr auf Geschwindigkeit, sondern auf Sicherheit ankommt. 

UDP User Datagram Protocol. Einfaches Netzwerkprotokoll, welches wie TCP meist auf IP ba-
siert. Die Übertragung erfolgt verbindungslos und verlorengegangene Pakete werden 
nicht wiederholt. Ist dafür schneller und hat weniger Verwaltungsaufwand. Von vielen 
Lichtprotokollen für die Lichtdaten verwendet, wo es in erster Linie auf Geschwindigkeit 
und nicht auf Übertragungssicherheit ankommt, da die Daten zyklisch wiederholt wer-
den. 

Universe Ethernet-Entsprechung einer DMX-Linie (512 Byte) 
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Technische Daten 

Allgemeine technische Daten 

Bauart: Tischgerät 
CPU-Typ: Infineon XC161 
Taktfrequenz: 40MHz 
Kühlung: lüfterlos betreibbar 
Abmessungen B x T x H: 245 mm x 110 mm x 190 mm 
Stromversorgung: Akku / externes Netzteil 12V DC / 3A 
Gewicht: 1,5 kg 
EMV-Standards: EN 55022, class B, FCC part 15, level B 
RoHS-conform: ja 
Konfiguration: Menüsystem mit Display und 4 Tasten 
Lieferumfang: Fertiggerät 
 
 

Schnittstellen 

DMX: XLR 5-pol. 
 
Ethernet: RJ45 
 IEEE-Belegung für 100BaseTx und 
 Power-over-Ethernet nach IEEE 802.3af 
 

DMX 

Allgemein 

DMX-Protokoll: DMX-512  
Standards: USITT 1990, DIN 56930-2, ANSI E1.11 
Baudrate: 250 kbps 
Eingang: potentialgetrennt  
 (ISOLATED nach ANSI E1.11 A1) 
Thru: parallel zum DMX-Eingang 
Potentialtrennung:    Optokoppler 
Isolationsspannung:    1000V DC 

Isolationswiderstand:   109  
EMV: Filterbeschaltung nach Stand der Technik 
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Empfang 

Startcode: =0    Lichtprotokoll         (in Display ●) 

 <>0  kein Lichtprotokoll, RDM  (in Display  E) 
minimale Protokollänge: nur Startcode 
maximale Protokollänge: Startcode + 512 Werte 
 (Werte über 512 gehen verloren) 

minimale Anzeigeverzögerung: 44 s 
maximale Anzeigeverzögerung: 22,5 ms 
Empfangstimeout: 2 s 
max. Abstand zwischen 2 Protokollen: 2 s 

Minimale erkannte Breaklänge: 48 s 
Maximal zulässige Breaklänge: 1,95 s 
 

 

Ethernet 

Allgemeines 

Schnittstelle: 10/100 BaseT (IEEE 802.3u, 802.3x) 
Geschwindigkeit: 10 MBit/s, 100MBit/s; Autonegotiation 
Duplex-Mode: halb, voll; Autonegotiation 
 Auto-MDI/MDIX 
Anzeige: Link-LED, Data-LED, Geschwindigkeit und Duplex-Mode 

werden im Display angezeigt 
Lichtprotokolle: Art-Net (ArtisticLicence) 
 AVAB-IPX (AVAB, transtechnik, LDDE,…) 

 AVAB/UDP (transtechnik) 
 ShowNet (Strand Lighting) 

 sACN (ANSI E1.17) 
weitere Netzwerkprotokolle: ARP, IP, IPX, UDP, IGMPv2 
 
 

Empfang 

Maximale Paketrate: >1000/s   (bei 1 Lichtframe/Paket) 

Minimale Durchlaufverzögerung: 4 s 
Maximale Durchlaufverzögerung: 22,7 ms 
Max. Abstand zwischen 2 Protokollen: 1...999 s  (Halten einstellbar) 
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Anschlussbelegung 

DMX Ports 

5 Pin XLR 

Belegung nach DMX512-Standard 

 

Pin Belegung 

1 Ground 

2 Data - 

3 Data + 

4 Spare 

5 Spare  

 

PE kann über die Schirmung geführt werden 

 

Ethernet 

 

Pin Belegung 

1 Rx + 

2 Rx - 

3 Tx + 

4  

5  

6 Tx - 

7  

8  

S Kabelschirm 

 


